PEARSON PowerTeacher

PowerTeacher

In this course you will explore what is available to teachers PowerTeacher, a web
portal to PowerSchool that concentrates all the features teachers need in one spot,
including a web-based gradebook. You will learn to:

¥

K K K K K

Take attendance and submit a lunch count

Submit student log entries and comments

Set up the PowerTeacher Gradebook

Enter assignments and record scores

Set up student groups and analyze classroom achievement trends

Print PowerTeacher reports

Hello PowerTeacher!

You can use PowerTeacher anywhere you have access to the Internet. Its features
and functions are tailored to duties and responsibilities teachers handle day-to-day.

1.

Open a Web browser and enter the address of your PowerSchool server
followed by /t eachers in the browser address bar.

Enter your username and password and then click Enter.

The PowerTeacher Start Page consists of three areas:

¥ Navigation Bar b located at the top of the screen. The Navigation Bar
provides access to the Start Page (via the PowerTeacher logo), the Report
Queue, Online Help, and the Logout Button.

¥ Main Menu D located at the left side of the screen. The Main Menu
provides access to the Start Page, the Daily Bulletin, and a display of your
Meal Balance, the Staff Directory, the Gradebook, and Reports.

¥ Current Classes b located in the center of the Start Page screen. The
Current Classes area provides information regarding the students in the
classes you teach, as well as to the tools for attendance, lunch count, and
reports.

. To log off PowerTeacher, click Logout in the upper right corner.
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Using the Student Information Screens

The following table provides a brief explanation of the student information screens
available in PowerTeacher. More detailed information is available in the
PowerTeacher online help.

Cumulative Grade
Information

Displays the student® GPA and class rank information.
Schools decide what information appears on this page.

Demographics

Displays the student® basic demographic information. It
also contains an email link to the parent or guardian.

Final Grade Entry
(Citizenship)

Use this page to enter a citizenship grade for the student.
Your school decides whether this page is active and what
codes appear on the page.

Final Grade Entry

Use this page to enter final grades and comments for
specific standards for the student. Your school decides

(Standards) whether this page is active.
. Displays the student® attendance record for the entire
Meeting . . .
term for every course in which he or she is currently
Attendance

enrolled.

Net/Phone Access
Summary

Displays a summary of the number of times that the
parents and student have accessed PowerSchool via the
Internet or by phone, if applicable.

Print a Report

Use this page to select a school-created report to print for
the student.

Quick Lookup

This is the default student page. Displays a summary of
the student® current grades and attendance for each
class. Click the blue links to access additional information.

Schedule

Displays the student® current class schedule.

Standards

Use this page to view the student® progress on specific
standards outlined by your state, district, and school.

Student Photo

Displays the student® photo, if your school has imported
student photos.

Submit Log Entry

Use this page to create a log entry for discipline or other
anecdotal information for the student® permanent record.

Teacher Comments

Displays comments entered by the teacher. Comments
can be free-form or selected from a comment bank.
Comments that are published can be viewed by parents or
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students via Parent Access.

Term Grades Displays the student® stored grades for the current year.

Activity 1 B Overview of PowerTeacher
Familiarize yourself with the functions of PowerTeacher.

1. Click through the buttons in the main menu to familiarize yourself with some
of the functions of PowerTeacher.

2. Click the PowerTeacher logo or Start Page on the Main Menu to return to
the Start Page.

Taking Attendance and Recording Lunch Counts

It is easy to take attendance and record lunch counts in PowerTeacher. As soon as
teachers take attendance that data is available to school administrators, parents,
and students. If all students are present teachers should still click the chair icon to
open the attendance screen, and then click Submit. This tells PowerSchool that the
teacher has taken attendance. Otherwise, the teacher@ name will be on a report
that displays teachers who have not taken attendance.

If teachers have more than one class during the same period, they can take
attendance for all of the students in the classroom at the same time by clicking the
Record MultiMeeting Attendance for Multiple Sections option.

Teachers record lunch counts by clicking the utensil icon for the appropriate class
and entering the count numbers. The count is included in the PowerLunch Class
Counts report.

Activity 2 B Enter Attendance
Take attendance for today in PowerTeacher.

1. Click the chair next to one of your classes.

2. Choose attendance codes from the menu and mark attendance for your
students.

3. Click Submit. The indicator located next to the chair is now green.

Activity 3 B Use the Student Information Screens
Add a Log Entry, a Comment, and Citizenship grade.

1. Click the backpack to enter the Student Information area of PowerTeacher,
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and then click a student's name.
2. From the Select screens menu, click Submit Log Entry.

3. Use the fields to draft a discipline log entry. Enter a subject such as
Fi ghti ngon Playground. Enter text such as Student was hit ti ngothers
duri ng | unchti meg and then click Submit.

4. Click the student's name again.

5. From the Select screens menu, click Teacher Comments. Then click Edit on
the line displaying your course.

6. On the Modify Comment page, select a comment from the comment bank.
Click the arrow to move it to the Comment field and click Submiit.

7. From the Select screens menu, click Final Grade Entry (Citizenship).
Choose a citizenship grade from the menu.

8. Click Submit and then return to the Start Page.

Working with the Gradebook

The following table provides a brief explanation of the icons teachers see when they
launch their gradebook.

Scoresheet Displays the assignments and scores entered for students
Assignments Displays the details of the assighments you have created
Students Displays demographic data for each student in the class
Grade Setup Displays the final grade setup for each term

Class Info Displays the basic information about the selected course
Reports Provides an interface to designate and format reports

Setting Up Categories

Categories are broad classifications in which similar types of assignments are
grouped. Examples of categories are homework, tests and quizzes. The
PowerTeacher Gradebook comes with four pre-defined category types. Teachers can
add additional categories and/or modify the default categories.

The following table provides an explanation of the fields used to set up categories.
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Name Enter the name of the category.
Abbreviation Enter an abbreviation for this category.
Color Choose the color for the category on the Scoresheet.

If there are a typical number of points possible for the

Points Possible category, enter the number of points possible.

Score Type Choose the Score Type for the category.

Very important! Select the check box if scores for
assignments in this category are to be used in the calculation
Include in Final of the final grade for the course.

Grade If this box is not checked, the scores will not count. Not
including an assignment in the final grade calculation would be
appropriate for an assignment like "turn in permission slip.O

Category descriptions are displayed in the Administrator and

Description
P Parent Access areas of PowerSchool.

Setting Up Final Grade Calculations
After teachers create assignment categories, they need to determine how the

students®inal grades will be calculated for each term. The options for final grade
calculations are discussed in the next three sections.

Total Points

This method calculates the student® final grade by dividing the points the student
has accumulated by the total number of points possible. Total Points is the default
setting for all terms.

Term Weights

This method multiplies a term grade by some value (or weight) to calculate a grade
in another term. For example, Semester 1 might be worth 40% of the final grade
and Semester 2 worth 60% . Percents can also be entered with decimal points, such
as 33.33%.

Category Weights

This method multiplies the total number of points by the value (or weight) of each
category. It allows you to set up the weights for each category according to your
personal plan or school requirements.
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Activity 4 B Format Final Grades

Set up final grade weighting for the 3" and 4™ quarters and the 2" semester.
1. Click the Grade Setup tab.
2. Click a term.

3. Select the final grade setup method that you will use in your classroom:
total points, term weights, or category weights. Then format the specifics.

4. Click Save and repeat for the remaining terms.

Gradebook Preferences

Use the preferences window to indicate how you want grades to be calculated,
stored, and displayed. Also, choose how to distinguish your different sections.
Preferences can be found in the PowerTeacher Gradebook menu (Mac) or the
Tools menu (Windows) at the top of the screen.

Class I nfo

The Class Info tab contains basic information about the course you selected in the
Classes pane. You can enter text in the Custom Display Name field to personalize
your class list and enter text in the Description field to communicate with parents
about class rules and your expectations of students, or give an overview of the
course and any other information that would be of interest to parents.

Activity 5 B Add Categories
Add two categories to your PowerTeacher gradebook.

1. From the Tools menu, choose Categories. The Categories window will
appear, displaying the pre-defined assignment categories.

2. Click the Plus (+) in the lower left-hand corner of the Categories window to
add a new category.

3. Enter information into the appropriate fields.
4. Click the Plus (+) to add the second category.

5. Click Close to save and close the Categories dialog box.
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Using PowerTeacher Gradebook in the Classroom

Setting up Student Groups

PowerTeacher Gradebook provides tools for creating sets and groups and choosing
students to include in the groups so that teachers can adapt instruction to the
needs of subgroups of students. Student group assignments are flexible; they can
be modified any time.

Definitions

¥
¥

Entire Class b default PowerTeacher Gradebook group.

Set D a collection of groups, i.e. Math or Reading. You must create the Set
before you can create a Group.

Group b a small collection of students, i.e. Mathl and Math2 or Bluebirds and
Redbirds.

Activity 6 B Create Sets and Groups
Practice adding one set and two groups.

1.
2.

Click the Students tab.

Click the Plus (+) in the lower left-hand corner of the PowerTeacher
Gradebook window. An Untitled Set 1 and Untitled Group 1 will appear.

Double-click on Untitled Set 1 and enter a name for the set. Press Enter.

Double-click on Untitled Group 1 and enter a name for the group. Press
Enter.

Click the Plus (+) again and choose Add Group.
Enter a name for your group and press Enter.

Click on a student's name and drag it into a group. Use command-click (Mac)
or Ctrl-click (Windows) to add multiple students.
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Assignments

Teachers can set up assignments at the beginning of a school term or at any time
during the term, and can make assignment information available to parents and
students.

After you create an assignment in the Assignment tab, it is displayed on the
Scoresheet. The name, point value, and date due for each assignment appear
above the column in which you will enter student scores. Double-clicking the
assignment heading (or clicking the arrow at the top) opens the assignment
definition window, where you can modify the assignment or publish criteria.

As you enter assignments you will notice a demarcation line that separates future
assignments from past assignments. Posting assignments before entering scores
does not skew how grades appear. The Final Grade that appears next to the
student® name on the Scoresheet reflects an average grade for only the
assignments that have already been scored. The following table provides a brief
explanation of the fields used to set up assignments.

Name Enter the assignment title.

The abbreviation will be auto-filled with the name of
Abbreviation the assignment. You can change the abbreviation.

Assign a category to the assignment from the list of
Category categories created previously. If the assignment does
not fit into any of the categories, create a new one.

The PowerTeacher Gradebook automatically displays
Score Type the score type you selected for this category. You can
change the score type.

The PowerTeacher Gradebook automatically fills in the
Points Possible default value designated for this category. You can
change this value.

Assign a weight to an assignment if it is worth more
than other assignments.

CAUTION! Keep a record of changes you make to the
weighting of individual assignments, and note how

Weight assignment weighting interacts with category
weighting.

A good rule of thumb is that if the assignment counts
more toward the final grade, make the assignment
worth more points rather than changing its weight.
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Due Date

Enter a due date for the assignment, if appropriate.
Some assignments may not have a due date. The
default due date for assignments is today@® date.

Include in Final
Grade

Select this check box if the assignment counts toward
the final grade.

Description

Enter a description and instructions for the assignment.
Students who missed school the day the assignment
was given can reference this information to complete
the work. If students need to use the Internet as part
of the assignment, you can link to online resources by
using this HTML code:

<a h re f= enter web address here
ta rg et = bl ank>click here</ a>

Publishing Assignments

Publishing an assignment makes it possible for parents and students to see it in
PowerSchool Parent Access. You can publish an assignment at the same time you
create it, or at any point afterward. PowerTeacher Gradebook defaults to publishing
assignments to the Parent Portal as soon as they are created. The Publish tab is
located in the assignment pane.

If an assignment is part of the student@® final grade, it must be published at some
point to the Parent Portal. You will receive an error message if you choose the
Never publish option for an assignment that is to count toward the final grade.

Refer to the table below as you enter information into the fields:

Publish
Assignment

Choose whether you want to Publish Immediately, On a
Specific Date, or Days Before Due.

On Date

Choose the date you want the assignment published.

Days Before Due

Choose the number of days before the assignment is due
that you want the assignment published.

Publish Scores

Place a checkmark in this box if you would also like to
publish the scores for the assignment.
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Activity 7 B Create a New Assignment
Create three homework assignments for use in the next modules.

1. Click the Plus (+) sign next to the Assignment header to open the New
Assignment pane.

2. Enter a name for the homework assignment and choose Homework as the
category. Set a due date and determine whether you wish to accept the
default values for score type and points. Choose whether to include the
homework assignment in the final grade. Enter a brief description.

3. Click the Publish tab. Choose when to publish the assignment.

4. Click Save in the lower right corner to save the assignment. The assignment
will appear in the Scoresheet. Repeat the steps for a second and third
homework assignment.

Copying Assignments

You can copy assignments from one class to another from current or previous term.
Copy Assignment can be found in the Tools menu at the top of the screen. The
gradebook window contains a menu to change classes, but also to select previous
classes. This will allow you to access any assignment no matter the date.

Weighting Assignments

When creating an assignment, the Weight field can be used to help keep grading
practices flexible, yet consistent. For most assignments, keeping the Weight at the
default value of 1.00 and using Points Possible to adjust how the assignment
contributes to the overall term grade is appropriate.

When scoring assignments with a letter grade score type, you do not need to be
concerned with points. Simply enter the letter grade for each assignment, and
weighting will automatically take care of the relative value for each assignment.

Activity 8 B Weighting Assignments

Use weighting to make a set of three quizzes worth 100 points, regardless of the
number of questions each contains.

1. Create three or more quiz-type assignments. Use information in the grid
below to fill in the number of points and weighting fields.

2. Based on the information in the grid, fill in the last column.

Copyright © 2008 Pearson Page 10



PowerTeacher

10 10 10
20 20 5
25 25 4

Recording Scores

As you record scores, match the type of score you enter to the tye you set up when
you created the assignment; numbers for points and percentage, letters for letter
grades.

Scores can be entered individually or by using the following quick-entry methods:
¥ To mark an assignment Exempt, type EXinto the cell on the spreadsheet.
¥ Click the equals sign (=) to assigh the maximum points possible.
¥ Enter Ml or a forward slash (/) to mark an assignment as missing.
¥ Enter LT or an asterisk (*) to mark an assignment as late.
¥ Enter CQL or a period (.) to mark an assignment as collected.

¥ Choose Fill Scores to mass fill a specific score.

Changing the number of Points Possible on an Assignment

Occasionally, after creating an assignment, you may determine that you need to
change the number of points that are possible on the assignment. Edit and save the
assignment. This will cause a warning will to appear. You may choose to keep the
scores you already entered, or have the computer adjust them based on the new
points possible.

Activity 9 B Record Scores
Record scores for the assignments you created.

1. Click the Scoresheet tab.

2. Click in the cell representing the intersection of the row containing a
student@ name and the column of the assignment you want to score. Then,
enter the score.

3. Press Return (Mac) or Enter (Windows) to advance to the next student, or
Tab to advance to the next assignment. Leave a few score cells empty.
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4. Use the Mass fill option for one of the assignments by choosing Fill Scores.

5. When you have finished entering scores, click Save.

Using the Score Inspector

The Score Inspector provides the ability to add notes to yourself about a student's
performance on an assignment. You can note if an assignment was received late, if
the student is exempt from completing the assignment, if the assignment is missing
or if you have collected the assignment without entering a point value. You can also
use the score inspector to enter a public comment. The following table provides a
brief explanation of the assignment indicators displayed in the teacher® gradebook.

Indicator Description Indicator Meaning

Small &Oin blue dot next to score There is a comment attached

Small A.0in red dot next to score ™ Assignment turned in late

Small MOin orange dot next to score Assignment is missing

Green check in a cell ¥ Assignment turned in but not graded
Italicized faint score Assignment does not count toward

final grade OR was marked as
exempt after scoring.

Small Hourglass in assignment heading £ | Assignment published on certain
date

Circle with line through it in assignment Assignment is never to be published

heading &

Small red exclamation mark next to Final grade changed by manual

italicized final grade © override

Yellow exclamation mark in the Scores are not published

assignment heading &

Activity 10 b Score Inspector

Use the Score Inspector to add score notes, and to mark assignments collected,
late, and exempt.

1. Click the Tools menu and click Score Inspector.

2. On the Scoresheet, click in the assignment column in the first empty cell next
to the appropriate student. In the Score Inspector, select the Collected box
instead of entering a score. You can replace the check mark with a score
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later. Mark a few more empty cells as Collected.
3. Click the down arrow to move to the next student. Select the Late box.
4. Click the down arrow to move to the next student. Select the Missing box.

5. Navigate to the student you have been assigned. Select the Exem pt Score
box for one assignment. Exempt a few more of the empty cells.

6. Click the right arrow to move to another assignment. Enter a comment in the
Score Inspector.

Note: The Clear button on the Score Inspector clears the score completely,
not just the comment or a Collected check.

7. Click on the term grade for your assigned student. Use the Score Inspector
to enter a comment. Note the Reporting Term here:
(Later in the class you will look at your comments and the exempt indicator
in PowerSchool Parent Access.)

8. Click Close and then click Save to retain the changes.

Manually Override a Final Grade

Occasionally, teachers need to modify a student® final grade in a course, based on
the student's effort, participation, or other classroom factors. The Score Inspector
allows you to change a final grade with the Manual Override tool.

Activity 11 B Manually Override a Final Grade

Manually override a student@® final grade that should be higher than the grade that
was calculated.

1. Double-click the final grade to open the Score Inspector, and then select the
Manual Override check box.

2. Change the percent and grade. Then, add a comment and click Close.

Assignment Statistics

The PowerTeacher Gradebook provides tools to view trends and to analyze student
scores mathematically. Assignment statistics provide information on each
assignment you enter into the gradebook.

To view the Statistics Summary, click Summary in the lower left corner of the
Scoresheet to see the mean, median, and mode values for each assignment. These
may also be viewed for the final grades.
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Reporting Features

The reports available through PowerTeacher Gradebook allow you to have a paper
or electronic copy of information. You have the ability to personalize each report by
entering a custom title or include a top note, bottom note, and signature line. There
are eight types of reports available in the following three output types:

¥ PDF b a cross-platform file that can be read and printed by Adobe Acrobat
Reader or Preview on a Mac or PC.

¥ HTML b a file that can be read by a browser such as Internet Explorer,
Firefox, or Safari.

¥ Text Export (CSV) b a text file consisting of the data, separated by commas.
This file can be opened with Excel or other spreadsheet software.

The following table provides a brief description of the reports:

Attendance Grid Student/date grid template for taking attendance

Category Total Report Summarizes category total

Final Grade and Comment Displays final grades for students and teacher
Verification comments by term

Displays a summary of the class activity per

Individual Student Report student

Displays assignments that are missing per

Missing Assignment i
9 9 assignment or per student

Scoresheet Displays a copy of the teacher(® gradebook

Student Multi-Section Report Includes grades from all of a student® sections

Student Roster Displays demographic information by class

Activity 12 b Explore the Reports

In pairs or groups of three, look at the different types of reports. Create a report as
a PDF, in HTML, and as an Export (CSV) report, so you can experience the different
report output options.

1. Click the Reports tab, and then click the type of report you would like to
view. The report options will become available in the lower pane on the
screen.

2. Select the Output Option you would like. This is not necessary for the
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Attendance Grid. Then, select the appropriate sections, students, sort order,
and date range for the report.

3. Click the Layout tab. Enter a custom title, top note, bottom note, or
signature line.

4. Click Run Report in the lower right corner of the screen.

5. Select to Open the report or Save the report. If Save is chosen, the report
will be saved in the output option and in the location you chose on your
computer.

PowerSchool Parent Access

Parent Access provides parents or guardians round-the-clock access to real-time
information about their child® attendance and grades. It also provides a means for
teachers to communicate with parents or guardians about class events,
assignments, and ways they can help their child at home. TeachersGemail
addresses are linked on the front page. Parents and guardians can elect to receive
periodic emails with attendance and grade updates.

To log on to Parent Access, parents need the following information from the
PowerSchool Administrator:

¥ Address of the PowerSchool server

¥ Their username and password

Activity 13 B PowerSchool Parent Access

Log in as a parent and click through the screens in PowerSchool Parent Access to
become familiar with the information parents can access.

Now, locate the comments that were entered via the PowerTeacher Student Screen
and via the PowerTeacher Gradebook.

1. Click Teacher Comments at the top of the PowerSchool Parent Access
Window. The comment you entered via the PowerTeacher Teacher Comment
screen appears in the comment column.

2. Click Grades and Attendance. Click the term for the class in which you
entered assignments and scores. The comment you entered on the term
grade appears under the table containing the grade information.

3. Notice that the score for the assignment you marked the student exempt has
a caret () next to it. This sign indicates that the score is exempt from the
final grade.

4. Click the score of an assignment for which you entered a comment. The
comment you entered appears in the score comment pages.
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